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Getting Started 

Objective 

This tutorial introduces you to the special capabilities of the Media Transport Toolkit 3D 

(MTT3D). MTT3D allows you to model sheets progressing through complex paper paths in 

three dimensions, allowing you to study 3D phenomena such as sheet corrugation and 

misalignment. In this tutorial, you will examine sheet corrugation in part of a printer device. 

Model Used 

The model used in this tutorial is the final portion of the paper path of a laser printer, namely 

the path that the sheet passes through before landing in the tray. To prevent paper jams and 

allow for an orderly stack of sheets in the output tray, a special multi-profile roller is used to 

corrugate the sheet to keep it straight before falling into the tray. The corrugation of the 

paper prevents the leading edge of the sheet from hanging down and dragging along the 

surface of the tray (or the sheets that are already in the tray). A side view of the model is 

shown below.  

Chapter 

1 
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As shown below, the corrugation roller works because the blue rollers have a larger radius 

than the lower purple rollers which rotate about the same axis.  Therefore, the blue rollers 

push the sheet upwards in between the purple roller pairs, distorting the sheet.  

If the corrugation effect is strong enough, the folds in the sheet cause it to resist gravity-

induced bending, allowing the sheet to remain straight as it exits the printer, as shown 

below. 
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Due to the limited time you may have to complete this tutorial, the rest of the printer is not 

modeled. Also, to simplify the model further, the sheet used is half the size of a standard A4 

sheet. Since the sheet is modeled as a mesh, this reduces the number of sheet bodies. 

Audience  

This tutorial is intended for experienced users of RecurDyn. All new tasks are explained 

carefully. 

Prerequisites 

Users should first work through the 3D Crank-Slider, Engine with Propeller, and Pinball (2D 

contact) tutorials, or the equivalent. We assume that you have a basic knowledge of physics. 
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Procedures 

The tutorial is comprised of the following procedures. The estimated time to complete each 

procedure is shown in the table below. 

Procedures  Time (minutes) 

Creating the Model 30 

Running a Simulation 10 

Modifying the Design 10 

Total 50 

 

Estimated Time to Complete 

50 minutes  
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Creating the Model 

Task Objective 

Learn how to define rollers, guides, and sheet bodies. 

Estimated Time to Complete  

30 minutes 

  

Chapter 

2 
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Creating a New Model and MTT3D Subsystem 

To create a new model: 

1. On your Desktop, double-click the RecurDyn 

tool. 

RecurDyn starts and the Start RecurDyn 

window appears.  

2. Enter Printer as the Model Name.  

3. Select OK. 

 

 

 

 

To create a new MTT3D subsystem: 

1. From the Subsystem Toolkit group in the Toolkits tab, click MTT3D. 

RecurDyn will bring you into the new MTT3D subsystem, and a new MTT3D tab will 

appear in the ribbon for the MTT3D functions. 

 

To adjust the Icon Size in the model: 

1. From the Render Toolbar, select the Icon Control 

tool.  

2. Change both the Icon Size and Marker Size from the 

default value of 10 to 3. 

To set the render mode to Wireframe: 

From Render Toolbar, select the Wireframe rendering 

tool. 
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Creating the Bottom Rollers 

You will now create the bottom roller pair in which the sheet starts. 

To create the bottom roller pair: 

1. From the Roller group in the MTT3D tab, click Pair. 

 

 

2. Select the point 0, 0, 0 in the Working Window to define the center of the fixed roller 

or type the values into in the Input Window. 

3. Enter 7.5 in the Input Window and press the Enter key to set the radius of the fixed 

roller. 

4. Select the +X direction, by clicking on a point directly to the 

right of 0, 0, 0.  The arrow which indicates the direction that 

will be selected should point directly to the right, as shown 

at right.  

5. Enter 7.5 in the Input Window to set the radius of the 

movable roller. 

You will now modify the bottom roller pair to have the correct 

properties. 

To edit the bottom fixed roller: 

1. From the Database Window, open the 

Properties window for MTT3D1 > 

Groups > FixedRollerGroup1.  

2. To the right of Contact Parameter, 

select the To Sheet button.  
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3. Make the following settings:  

▪ Stiffness:  1.2 

▪ Maximum Damping:  1.2e-4 

 

 

 

 

 

 

 

Note: If the checkboxes next to a parameter is checked, the value displayed will be considered 

a Special Parametric Value (SPV) and be used for all other fixed rollers in the model which have 

the same checkbox checked.  There are separate sets of SPVs for movable rollers and other 

model entities. 

Note: Here, you increased the contact stiffness to prevent the roller from penetrating the sheet 

excessively, as you will be increasing the nip spring stiffness of the opposing roller from its 

default value later.  Excessive contact penetration reduces the accuracy of the simulation.  At 

the same time, increasing contact stiffness too much will slow down the simulation.  Therefore, 

a general rule of thumb is to allow for penetration which is ~25% the thickness of the sheet. 

 

Also, the damping was increased by the same factor as the stiffness.  When adjusting stiffness 

and damping values, a good practice is to start with the default values and scale them both by 

the same factor.  If necessary, they can be adjusted individually later. 

4. Select Close. 

5. Select OK. 

To edit the bottom movable roller: 

1. From the Database Window, open the 

Properties window for MTT3D1 > Groups > 

MovableRollerGroup1. 

2. Select the Nip Spring Property button.  
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3. Uncheck the boxes next to Stiffness, Damping, and Pre Load.  

Note: By unchecking the boxes, you are specifying that the parameter values set for this 

roller will not be linked to the Special Parametric Values used for other movable rollers in the 

model. 

 

4. Make the following settings as shown 

right. 

▪ Stiffness:  0.1 

▪ Damping:  1e-2 

▪ Pre Load:  0.5 

5. Click the Close button to return to the 

Properties of MovableRollerGroup1 

dialog. 

 

6. To the right of Contact 

Parameter, select the To Sheet 

button. 

7. Make the following settings as 

shown at right. 

▪ Stiffness:  1.2 

▪ Maximum Damping:  

1.2e-4 

▪ Friction Coefficient:  0.2 

 

 

 

 

Note: A lower friction coefficient of 0.2 was chosen for this movable roller, because we want 

to model its surface as plastic. The default friction coefficient of 1.0 was used for the fixed roller, 

on the other hand, because we want to model its surface as being rubberized so it can grip the 

sheet. 

 

8. Click Close. 

9. Click OK. 
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Creating the Top Rollers 

You will now create the top rollers, starting with the first top roller pair, which will be 

duplicated three times for a total of four roller pairs on top. 

To create the first top roller pair: 

1. Select the Pair tool from the Roller group under the MTT3D tab in the ribbon. 

 

 

2. Enter the point -31.446, 45.228, 81 in the Input Window for the center of the fixed 

roller. 

3. Enter a radius of 5 in the Input Window for the fixed roller. 

4. Enter a direction of 1, 1.7321, 0 in the Input Window to specify the movable roller 

location. 

5. Enter a radius of 5 in the Input Window for the movable roller. 

At this point, your model should appear as shown below. 

 

You will now edit the top roller pair to have the correct properties before duplicating it. 
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To edit the first top fixed roller: 

1. From the Database Window, open 

the Properties window for MTT3D1 

> Groups > FixedRollerGroup2. 

2. Enter a Depth of 20. 

3. Check the box next to Check Edge in 

the lower right of the dialog box.  

4. Click OK.  

 

 

 

 

 

 

 

 

 

Note: The Check Edge option should be selected when a roller’s radius is smaller than the 

length of an individual element in the sheet mesh.  When this condition occurs, the contact 

between the ends of the roller and the sheet must be taken into account. 

 

To edit the first top movable roller: 

1. From the Database Window, open the 

Properties window for MTT3D1 > Groups 

> MovableRollerGroup2. 

2. Enter a Depth of 20.  

3. Check the box next to Check Edge. 

4. Select the Nip Spring Property button.   

 

 

 

 

 

 

 

5. Make the following settings as shown at 

right. 
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▪ Stiffness: 1e-2 

▪ Damping: 1e-3 

▪ Pre Load: 5e-2 

6. Click Close. 

7. Click OK. 

 

 

 

Because the top movable rollers are small, spring mounted, and their rotation is not specified 

with a motion input, their behavior is highly influenced by the sheet and the corresponding 

fixed roller. Because of this, it is important to set the mass and inertia properties to 

reasonable values to ensure accurate results.  In our model, we will specify that the roller is 

made of Nylon. 

To edit the mass properties of the first top movable roller: 

1. To bring up the Properties dialog for the body 

MovableRollerBody2 and not the group 

MovableRollerGroup2. 

▪ In the Database Window, locate but do not click 

on MTT3D1 > Bodies > MovableRollerBody2.  

▪ Without selecting it first, right-click on 

MovableRollerBody2, and select Property as 

shown at right. 

 

 

 

 

 

 

2. Select the Body tab.  
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3. For Material Input Type, select 

Library.  Click OK on the warning 

dialog that pops up. 

4. For Material Type, select Nylon. 

5. Click OK. 
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The roller pair is ready to be duplicated.  But first, you will want to change some of the 

program user settings to make copying and pasting easier. 

To change the program user copy/paste settings: 

1. From the Home tab in the Ribbon, select the General tool in the Model Setting group.  

 

2. Uncheck the box next to Shift when pasting.  

3. Click OK.  
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You will now make copies of the second roller pair and array them through the -Z direction to 

create the row of top driving roller pairs. 

To duplicate the first top roller pair: 

1. In the Database Window, select both 

FixedRollerGroup2 and MovableRollerGroup2: 

▪ First select FixedRollerGroup2. 

▪ Then hold down the Ctrl key and select 

MovableRollerGroup2.   

The associated bodies, joints, and forces will be selected 

automatically as shown at right. 

2. From the Clipboard group under the Home menu, 

select Copy.  (Or press Ctrl-C.) 

3. From the Clipboard group under the Home menu, 

select Paste.  (Or press Ctrl-V.) 

4. Repeat the previous step (Paste) twice, so that there 

are a total of four identical roller pairs. 

To move the duplicated roller pairs into place: 

1. In the Database Window, use the Ctrl key to select 

C1_FixedRollerGroup2 and 

C1_MovableRollerGroup2. 

2. From the Advanced Toolbar, select the Basic Object 

Control tool.  

3. For the Offset Value, enter 54.  

4. Click the -Z button. 

The first copy of the nip pair should 

have been translated 54 mm in the -Z 

direction. 

 

 

 

5. In the Database Window, use the Ctrl key to select C2_FixedRollerGroup2 and 

C2_MovableRollerGroup2. 

6. In the Basic Object Control dialog, click the -Z button twice to move it 108 mm in 

the -Z direction. 

7. In the Database Window, use the Ctrl key to select C3_FixedRollerGroup2 and 

C3_MovableRollerGroup2. 

8. In the Basic Object Control dialog, click the -Z button three times to move it 162 

mm in the -Z direction. 
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To create the multi-profile corrugating 

roller: 

1. Select the Fixed tool from the Roller 

group under the MTT3D tab in the 

ribbon. 

 

 

2. Enter -31.446, 45.228, 0 into the 

Input Window as the roller center. 

3. Enter a radius of 2.5 in the Input 

Window for the fixed roller. 

4. Open the Properties window of 

FixedRollerGroup3.  

5. Check the box next to Check Edge. 

6. Click the Multiple Roller Info. button.  

 

 

 

7. Click the Add button three times and 

enter the following roller data as 

shown at right. 

Radius Depth Distance 

5.5 10 -54 

5.5 10 0 

5.5 10 54 
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Note: To understand how the above variables apply to the rollers, click the Dimension 

Information button to display the diagram shown at above. When finished, click Close to 

close the window.  

 

8. Click the Close button. 

9. To the right of Contact 

Parameter, click the To Sheet 

button. 

10. Uncheck the box next to Friction 

Coefficient.  

11. Enter a Friction Coefficient of 

0.2. 

12. Click Close. 

13. Click OK.  

 

 

 

 

Your model should appear as shown below (rotated and rendered in the Shaded mode). 

 

14. Save your model. 
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Adding Motion to the Fixed Rollers 

You will now add motion to the fixed rollers, defining expressions which will ramp the 

rotational velocity up from zero to end values which will move the sheet at a linear velocity of 

400 mm/sec.  The end values will differ depending on the radius of the roller, but you will 

enter the expressions in such a way that RecurDyn will perform the calculations for you. 

 

To add motion to the bottom fixed roller: 

1. From the Database Window, open the 

Properties window for MTT3D1 > 

Groups > FixedRollerGroup1. 

2. Check the Include Motion checkbox 

and select the Motion button next to it.  

 

 

 

 

 

 

 

 

 

 

 

3. Choose Velocity (time) from the 

dropdown as the variable to 

control. 

4. Select the EL button to open the 

Expression List dialog.  
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5. Select the Create button to create a new expression. 

6. As shown below, enter a Name of Ex_bottomRollerVelocity.  

  

7. Enter the following expression, which references the desired velocity and the roller 

radius: 

▪ (400/7.5)*STEP(TIME, 0, 0, 0.1, 1) 

8. Select OK four times. 

To add motion to the top fixed rollers: 

1. From the Database Window, use the Ctrl key to select the following. 

▪ FixedRollerGroup2 

▪ C1_FixedRollerGroup2 

▪ C2_FixedRollerGroup2 

▪ C3_FixedRollerGroup2 

2. Right-click on one of the items and select Property. 

3. Check the box next to Include Motion and select the Motion button. 

4. Choose to control Velocity (time) from the dropdown. 

5. Select the EL button to open the Expression List dialog. 

6. Select the Create button to create a new expression. 
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7. As shown above, enter a Name of Ex_topRollerVelocity. 

8. Enter the following expression: 

▪ (400/5) * STEP(TIME, 0, 0, 0.1, 1)  

9. Click OK four times. 

Creating the Guides 

You will now create the arc, linear, and edge guides which the sheet will proceed through. 

To create the inner arc guide: 

1. Return to view the standard X-Y plane. (Shortcut is the Shift + x key.) 
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2. Select the Arc tool from the Guide group 

under the MTT3D tab in the ribbon. 

 

3. In the Input Window, enter a center 

point of -31, 6. 

4. Enter a start point of 7, 6. 

5. Enter a reference direction of 0, 1. 

6. Enter an angle of 60 degrees.  

The first guide should now appear as 

shown at right.  (You will duplicate this 

inner guide later to create an outer 

guide.) 

 

 

 

 

7. From the Database Window, 

select MTT3D1 > Guides > 

GuideArc1, and open the 

Properties dialog. 

8. Check the box next to Check 

Edge. 

9. To the right of Contact 

Parameter, select To Sheet.  
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10. Set the Friction Coefficient to 0.2.  

This will set the default friction 

coefficient for all guides to this value. 

You will now adjust the contact 

direction to ensure that it points in 

the correct direction.  

 

 

 

 

 

 

 

 

11. Back in the Properties of GuideArc1 dialog, to the right of Contact Direction, click 

the Preview button. Click on the Up button. 

A small arrow indicating the direction of contact 

should appear, as shown at right. 

 

 

 

 

12. Press the Esc key to exit the preview mode. 

13. If the arrow did not point in the direction shown at right, change the Contact Direction 

using the Up and Down radio buttons. 

14. Click OK to exit the Properties window. 
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To create the outer arc guide: 

1. In the Database Window, select MTT3D1 > Guides > GuideArc1. 

2. Duplicate GuideArc1 using the Copy and Paste commands as done before. 

3. From the Database Window, select 

MTT3D1 > Guides > 

C1_GuideArc1 and open the 

Properties dialog.  

4. Enter a Radius of 40.  

5. Select Apply. 

 

 

 

 

 

 

 

 

 

 

6. As before, ensure that the 

contact direction is pointing the 

right way.  It should appear as 

shown at right. 

7. Click OK.  
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To create the inner linear guide: 

1. Select the Linear tool from the Guide group under the MTT3D tab in the ribbon. 

 

 

2. In the Input Window, enter a start point of -20.660, 43.909. 

3. In the Input Window, enter an end point of -12.000, 38.909. 

To create the outer linear guide:  

1. Select the Linear tool from the Guide group under the MTT3D tab in the ribbon. 

 

 

2. In the Input Window, enter a start point of -11.000, 40.641. 

3. In the Input Window, enter an end point of -19.660, 45.641. 

The model should now look as shown below. 

 

 

 

You now need to create small circular guides at the edges of the existing guides.  It is always 

a good practice to do this in order to prevent penetration of the edges of the guides into the 

faces of the sheet bodies.  The reason this is necessary is because the arc and linear guides 

Added Linear 

Guides 
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contact only the edges of the individual sheet bodies, while the circular guides contact both 

the faces and the edges of the sheet bodies. 

 

To create the circular guides: 

1. Select the Circular tool from the Guide group under the MTT3D tab in the ribbon. 

 

 

2. In the Modeling Window, select the left end of the 

outer linear guide you just created (GuideLinear2), as 

shown at right.  

 

 

 

 

 

 

3. In the Modeling Window, move the mouse pointer 

above the guide such that the OrthoDirection arrow 

points upwards, as shown at right, and click.  

 

 

 

 

 

 

4. In the Input Window, enter a radius of 0.2. 

5. Repeat the steps above for the three other guides as shown below. 
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To create the printer tray: 

1. Create three more linear guides, using the following start and end points. 

 Start Point End Point 

GuideLinear3 -351, 6 -51, 6 

GuideLinear4 -351, 26 -351, 6 

GuideLinear5 -51, 6 -51, 26 
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2. Open the Properties dialog for 

GuideLinear5, the guide on the right 

side of the tray.  

3. To the right of Contact Parameter, 

select the To Sheet button. 

4. Uncheck the boxes next to Stiffness 

and Maximum Damping.  

5. Make the following settings. 

▪ Stiffness:  1.2 

▪ Maximum Damping:  1.2e-4 

 

 

Note: The stiffness of the contact for GuideLinear5 should be increased to prevent contact 

penetration of the sheet edge into the guide at the end of the simulation.  This can occur 

because after the sheet lands in the tray, it slides down until it hits GuideLinear5.  Only the 

edge of the sheet contacts GuideLinear5, leaving less sheet bodies to react to the impact, and 

also the sheet’s direction of travel is exactly normal to the guide.  Both these conditions make 

this guide more susceptible to being penetrated by the sheet.  Another setting, the Maximum 

Time Step of the simulation, will also be adjusted later to prevent the same event. 

6. Click Close. 

7. Click OK. 

The model should now appear as shown below, with the tray flat.  You will next rotate the 

tray about a reference marker at the right corner of the tray so that it is sloped. 

 

To rotate the paper tray:  

1. Select the Marker tool from the Marker and Body group under the Professional tab 

in the ribbon. 

 

 

2. In the Modeling Window, click anywhere in the background to associate the Marker 

with the MotherBody. 

3. In the Input Window, enter the coordinates -51, 6. You will see a new marker at the 

right corner of the paper tray. 

4. Using the Ctrl key, select the three guides that make up the tray. 

5. From the Advanced Toolbar, select the Basic Object Control tool. 
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6. Select the Rotate tab.  

7. Enter 15 degrees for the angle.  

8. Under Reference Frame, click 

the M button.  

9. From the Modeling Window, 

select MotherBody.Marker8 

(the marker you just created). 

10. Click the Clockwise about Z 

button.  

11. Close the Basic Object Control 

dialog. 

The tray should now appear as shown below. 

 

Creating the Sheet 

You will now create the sheet and position the lower rollers around it. 

To create the sheet: 

1. Select the Shell tool from the Sheet group under the MTT3D tab in the ribbon. 

 

 

2. In the Input Window, enter a start point of 7.525, 5. 

3. In the Input Window, enter a direction of 0, -1. 
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4. The SheetShell dialog should appear 

as shown right.  If it does not, move 

the mouse pointer into the Modeling 

Window and it should appear. 

5. Make the following settings in the 

SheetShell dialog shown at right.  

▪ Thickness: 0.05 

▪ Total Length (Longitudinal): 

150 

▪ Number of Node 

(Longitudinal): 41 

6. Select the checkbox next to Air 

Resistance Coefficient. 

7. Click OK. 
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The sheet has been created, but if you were to 

zoom into the sheet where it is between the 

rollers, you would see that it is penetrating the 

rollers and that the rollers have not been 

separated enough to accommodate the sheet, 

as shown at right.  Therefore, the next step will 

be to align the sheet and rollers in a reasonable 

starting position. 

To align the sheet within the rollers:  

1. Select the Align tool from the Roller group 

under the MTT3D tab in the ribbons. 

 

2. In the Modeling Window, select 

SheetShell1, the sheet group you just 

created. 

3. In the Modeling Window, select 

MovableRollerGroup1, the roller to the 

right of the sheet. 

4. Select OK when asked whether to align the 

sheet or not. 

The sheet and movable roller should now have been moved into position as shown at 

right. 

5. Save the model. 
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Running a Simulation 

Task Objective 

In this chapter, you will start a simulation and monitor its progress.  Later, to save time, you 

will open a model identical to the one you created which will already have results for a 

complete simulation loaded and observe the results. 

Estimated Time to Complete  

10 minutes 

  

Chapter 

3 
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Improving Contour Plot Display 

Before running the simulation, you will change the Stress Recovery setting for the sheet 

body.  This setting should be made in most models with flexible bodies for the contour plots 

to be interpreted correctly.  

To set the stress recovery type to center: 

1. Select the Flexibility tool from the 

Model Setting group under the 

Home tab in the ribbon. 

2. Select the FFlex tab.  

3. In the Stress Recovery Type 

region, select Center.  

4. Click OK. 
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Running a Simulation 

You will now start a simulation and monitor its progress. 

To run the simulation: 

1. Select the Dyn/Kin tool from the Simulation Type group under the Analysis tab in 

the ribbon. 

2. Make the following settings, as shown at 

right. 

▪ End Time: 1 

▪ Step: 200 

 

 

 

 

 

 

 

 

 

 

3. Select the Parameter tab. 

4. Change Maximum Time Step to 1e-3.  

Note: For this simulation, the maximum time step 

should be reduced to prevent penetration of the 

sheet edge into GuideLinear5 on the right side of the 

tray.  This can occur because near the end of the 

simulation, when the sheet is simply sliding down 

the tray, the integration time step can become too 

large since the motion of the sheet is very simple.  

The sheet continues to slide until it hits the bump 

stop at the right side of the tray, GuideLinear5.  If 

the time step is too large at this point, the 

simulation can jump too quickly from one state in 

which the sheet edge is on one side of the bump 

stop to another in which the sheet edge is on the 

other side, without registering the sheet-to-guide 

contact correctly in between. 

 

5. Click Simulate and allow the simulation to 

run for several minutes. 

While the simulation is running, you can stop it and play the animation of the completed 

results to monitor its progress. 
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To monitor the simulation:  

1. From the Simulation Toolbar, click the Pause Analysis button. 

The animation controls should now become active. 

2. From the Simulation Toolbar, click the Play button.  You can use any of the 

animation controls to view the results as if the simulation were complete. 

With the simulation at about 20% complete, you should see that the sheet has 

progressed through the guides and has started entering the corrugating roller pair, as 

shown below.  At this point, the simulation will run slower due to the higher amount of 

sheet deformation and contact which will occur during its corrugation. 

 

3. From the Simulation Toolbar, click the Resume Analysis button, in order to continue 

the simulation. 
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Viewing the Completed Simulation Results 

If you have a powerful desktop computer with multiple processing cores, the simulation can 

take less than one minute to complete.  However, due to the limited time you may have to 

complete this tutorial, you will now open an identical model which already has results from a 

complete simulation loaded. 

To open the completed model:  

1. From the Simulatoin Toolbar, click the Stop Analysis button. 

2. From the File menu, select Open. 

3. Navigate to the tutorial subdirectory labeled Printer_complete. 

4. Select the file Printer_complete.rdyn. 

5. Select Open. 

6. Enter the MTT3D1 subsystem. 

▪ In the Database Window, right-click on Subsystems > MTT3D1, and select 

Edit. 

OR 

▪ In the Modeling Window, double-click on any geometric entity of the MTT3D1 

subsystem. 

If the animation controls are grayed out, you will need to import the animation results from 

the previously completed simulation. 

To import the animation: 

1. From the File menu, select Import. 

2. Select the file Printer_complete.rad. 

3. Select Open. 
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You should now be able to view the results for a complete simulation of the system, by using 

the standard animation controls. You should see that the paper corrugates, but that it bends 

downward before exiting the corrugating roller pair, as shown below.  This causes it to land 

awkwardly within the paper tray. 
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In order to see where the corrugation is occurring more easily, you can display the contour 

plot of stress within the sheet. To see the contour you need to run the simulation on your 

own computer so that the .erd, .rfa, and .srd FFlex output files are available. 

To view the stress contour plot: 

1. Select the Contour tool in the Contour group under the MTT3D tab. 

 

 

2. In the Contour Option section, from the Type dropdown menu, select Stress. 

3. Select SMISES from the displayed list of data types. 

4. In the Min/Max Option section, from the Type dropdown, select User Defined. 

5. Enter a Max value of 1. 

6. In the Style Option section, from the Style dropdown, select Smooth. 

7. Also set the Text Color to be black. 

8. Click OK. 
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The areas of high stress indicate where the corrugation is occurring as the sheet proceeds out 

of the rollers.  In the second frame below, you can see when the corrugation dissipates due 

the increasing mass of the sheet away from the rollers, before the sheet is released. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The simulation shows that the design does not maintain the corrugation in the sheet for as 

long of a time as intended. In the next chapter, you will modify the design to increase the 

corrugation effect. 
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Modifying the Design 

Task Objective 

In this chapter, you will modify the design of the corrugation roller to increase the 

corrugation, in an effort to keep the sheet straight until it exits the printer.  You will then 

import simulation results for the modified design and evaluate its performance. 

Estimated Time to Complete  

10 minutes 

  

Chapter 

4 
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Modifying the Design 

In order to increase the corrugation of the paper, the radius of the corrugating rollers will be 

increased. After that, all the upper rollers will be repositioned such that they remain aligned 

with the centerline of the linear guides, as shown below. 

To increase the radius of the corrugating rollers: 

1. Return to your model. 

2. Open the Properties dialog of 

FixedRollerGroup3, the corrugating 

roller. 

3. Click the Multiple Roller Info. button.  

4. Change the Radius values to 6.5, as 

shown at right.  

5. Click Close. 

6. Click OK. 

 

 

 

Step 1: 

Increase Corrugating Roller Radius 

Step 2: 

Realign Upper Rollers with 

Linear Guide Centerline 
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To realign the upper rollers: 

1. In the Database Window, use the Shift key to select 

all the items under Groups except for 

FixedRollerGroup1 and MovableRollerGroup1. 

▪ Select FixedRollerGroup2. 

▪ Hold down the Shift key. 

▪ Select FixedRollerGroup3. 

2. From the Advanced Toolbar, select the Basic Object 

Control tool. 

3. Enter an Offset Value of 0.5. 

4. Under Reference Frame, click the M button. 

5. In the Modeling Window, select a marker which is 

aligned with the axes of the springs, as shown 

at right. 

6. Click the -Z button, or whichever button will 

move the rollers down and to the left. 

7. Close the Basic Object Control dialog.  

8. Save the model under a different name, such 

as Printer_update.rdyn. 
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Evaluating the Design Change 

The revised model is ready to simulate, but as before, you can open an identical model with 

previously completed simulation results, to save time. 

To open the previously completed model: 

1. Open the file Printer_update.rdyn, located again in the Printer_complete tutorial 

subdirectory. 

2. Enter the MTT3D1 subsystem. 

3. If the animation controls are grayed out, import the animation file Printer_update.rad. 

4. Enable the contour plots as done before. 

The results should now show an increased amount of corrugation, enabling the sheet to 

successfully remain straight until exiting the printer, as shown in the following figures. 

 

Figure 3: Sheet remains straight as it exits printer. 
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Figure 4: Sheet lands near flat in tray. 
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Note:  In the modified model, you may notice some penetration of the sheet into the outer 

arc guide, as shown below. 

 
Although this may appear to be a lot of penetration, it actually is not excessive. If viewed from 

the side, as shown below, you can see that the sheet is staying within the boundaries of the 

guides and the penetration is only on the order of 0.1 mm. 

 
In addition, this penetration has little effect on the outcome of the simulation as the overall 

behavior of the sheet is very reasonable. 

The penetration could be reduced if the contact stiffness of the guides were increased, however, 

this would also make the simulation slower by decreasing the integration step size. Therefore, 

a general rule of thumb is that the contact stiffness should be as low as possible while still 

enabling the model to behave reasonably. 

 

 

 

Thanks for participating in this tutorial! 
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